DOLI Elektronik GmbH

<table>
<thead>
<tr>
<th>Corporate name:</th>
<th>DOLI Elektronik GmbH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headquarters:</td>
<td>Adi-Maislinger-Straße 7, 81373 München, Germany</td>
</tr>
<tr>
<td></td>
<td>📞 +49-(0)89-20 243-0</td>
</tr>
<tr>
<td></td>
<td>Fax +49-(0)89-20 243-243</td>
</tr>
<tr>
<td></td>
<td>e-mail <a href="mailto:info@doli.de">info@doli.de</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Production:</th>
<th>Ulmer Straße 34, 89584 Ehingen, Germany</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>📞 +49-(0)7391-58039-0</td>
</tr>
<tr>
<td></td>
<td>Fax +49-(0)7391-58039-71</td>
</tr>
<tr>
<td></td>
<td>e-mail <a href="mailto:ehi@doli.de">ehi@doli.de</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sales:</th>
<th>Mühlstr. 26, 55271 Stadecken-Elsheim, Germany</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>📞 +49-(0)6130-944250</td>
</tr>
<tr>
<td></td>
<td>Fax +49-(0)6130-944251</td>
</tr>
<tr>
<td></td>
<td>e-mail <a href="mailto:sales@doli.de">sales@doli.de</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Internet:</th>
<th><a href="http://www.doli.de">www.doli.de</a></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><a href="http://www.flexometer.com">www.flexometer.com</a></td>
</tr>
</tbody>
</table>

(Version 2.0.0.1, Release: 08.05.2008)
Table Of Contents

1. INTRODUCTION ......................................................................................................................................... 5
   1.1. SAFETY HINTS ................................................................................................................................. 6
      1.1.1. General Safety Hints .................................................................................................................. 6
      1.1.1.1. Warning Signs and Hints ...................................................................................................... 6
      1.1.1.2. Demands on personnel ........................................................................................................ 6
      1.1.2. CE-Conformity, Directions and Standards .............................................................................. 7
      1.1.3. Specified normal Operation ...................................................................................................... 8
   1.2. DESCRIPTION OF THE DOLI ULTIMATE COMPRESSION FLEXOMETER ........................................... 9
      1.2.1. The System ............................................................................................................................... 9
      1.2.2. The Actuator ............................................................................................................................ 10
      1.2.2.1. Vibration Absorbing System .............................................................................................. 11
      1.2.3. The Sample ............................................................................................................................. 11
      1.2.3.1. Hardness of the sample ....................................................................................................... 11
      1.2.3.2. The lower Holder ................................................................................................................. 11
      1.2.3.3. The Input Station ................................................................................................................. 11
      1.2.4. The Temperature Chamber .................................................................................................... 12
      1.2.5. The Preheat Station .................................................................................................................. 12
      1.2.6. The Magazine .......................................................................................................................... 12
      1.2.7. The Handlingarm System ....................................................................................................... 13
      1.2.8. The Height Measurement Station ............................................................................................ 14
      1.2.9. The Puncture Needle ............................................................................................................... 14
      1.2.10. The Output Station (Garbage) ............................................................................................... 14
   1.3. SPECIFICATIONS ............................................................................................................................... 15
   1.4. ONLINE - HELP ................................................................................................................................ 16

2. OPERATION .................................................................................................................................................. 17
   2.1. SECURITY ............................................................................................................................................ 17
      2.1.1. Sensors of the Temperature Chamber ...................................................................................... 17
      2.1.1.1. Front Door ........................................................................................................................... 17
      2.1.1.2. Rear Door ............................................................................................................................ 17
      2.1.1.3. Position of the Temperature Chamber ................................................................................... 18
      2.1.2. Sensors of the Magazine ......................................................................................................... 18
      2.1.3. Overview ................................................................................................................................... 19
   2.2. FLEXOMETER ..................................................................................................................................... 20
      2.2.1. Switch-On ................................................................................................................................. 20
   2.3. PROGRAM .......................................................................................................................................... 21
      2.3.1. Start and Control ....................................................................................................................... 21
      2.3.1.1. Start of the Program ............................................................................................................. 21
      2.3.1.2. Control with the Function Fields ......................................................................................... 24
      2.3.1.3. Control with the Popup-Menu ............................................................................................ 25
      2.3.1.4. Control with the Main Menu Line ....................................................................................... 26
      2.3.2. Flexometer Settings .................................................................................................................. 28
      2.3.2.1. Hardware ............................................................................................................................. 28
      2.3.2.2. File Management ................................................................................................................ 29
      2.3.2.3. Filename .............................................................................................................................. 29
      2.3.2.4. Language/Print/Formula .................................................................................................... 30
      2.3.2.5. Display .................................................................................................................................. 31
2.3.2.6. Graphic .......................................................................................................................... 31
2.3.2.7. Security .......................................................................................................................... 32
2.3.3. Sample Parameters .............................................................................................................. 33
   2.3.3.1. Input of the sample parameters .................................................................................. 33
2.3.4. Status Information .............................................................................................................. 37
   2.3.4.1. Supervisor Menu ........................................................................................................ 37
   2.3.4.2. Signals Menu .............................................................................................................. 38
   2.3.4.3. EDC - Messages ......................................................................................................... 39
   2.3.4.4. Legend ....................................................................................................................... 40
   2.3.4.5. Invalid Samples ........................................................................................................... 40
3. TEST ........................................................................................................................................... 41
   3.1. GENERAL TEST DESCRIPTION ..................................................................................... 41
   3.2. FLEXTEST ........................................................................................................................ 42
   3.3. BLOWOUT TEST DEFORMATION/TEMPERATURE ........................................................... 43
   3.4. VISCOELASTIC PROPERTIES ......................................................................................... 44
4. RESULTS .................................................................................................................................... 45
   4.1. RESULTS OVERVIEW ....................................................................................................... 45
   4.2. SINGLE RESULTS ............................................................................................................. 47
   4.3. PRINTOUTS ....................................................................................................................... 48
   4.4. EXPLANATION OF THE RESULTS .................................................................................. 49
5. MAINTENANCE .......................................................................................................................... 51
   5.1. MAINTAINING THE INSTRUMENT ................................................................................... 51
      5.1.1. Draining of the Compressed-air System ...................................................................... 51
      5.1.2. Changing the lower holder ........................................................................................ 52
      5.1.3. Changing the puncture needle ...................................................................................... 53
      5.1.4. Cleaning the Stations .................................................................................................. 54
   5.2. SPARE PARTS .................................................................................................................... 55
6. APPENDIX ................................................................................................................................... 56
   6.1. WHERE IS THE SAMPLE? ............................................................................................... 56
1. INTRODUCTION

Dear customer, thank you for choosing the Ultimate Compression Flexometer from DOLI Elektronik GmbH. This manual will help you to get familiar with the instrument soon and it will help you to be able to answer questions and solve problems that may arrive during the operation.

- You will get a description of your new instrument.
- You will get an installation and user manual.
- You will get a description of the Flexometer test procedure.

© 2004 DOLI Elektronik GmbH. All rights reserved.
1.1. Safety Hints

1.1.1. General Safety Hints

Read this manual carefully before starting with the installation and operation of the Flexometer. False handling of the instrument can cause severe damage to persons and property. It is essential to adhere to the technical directions and connection conditions from the name plate and documentations.

1.1.1.1. Warning Signs and Hints

This manual contains several symbols, that will allow you to find your way more easily. Furthermore, the manual contains warning signs adverting to possibly dangerous situations. These warning signs may be found on the instrument, too. It is essential to adhere to the warning signs and the related hints:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>Safety Instructions: In order to avoid interruptions in the work flow as well as damages to man and machine, follow the safety instructions at all cost.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Safety Instructions: Danger by electricity and its effects In order to avoid interruptions in the work flow as well as damages to man and machine, follow the safety instructions at all cost.</td>
</tr>
<tr>
<td>🔄</td>
<td>Job/work instructions: Instructive part of the document with precise work instructions Here you are asked to do something.</td>
</tr>
<tr>
<td>🚩</td>
<td>Information: General information and descriptions of working procedures, etc.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Note: Important note for the operation, the function or for the working procedures.</td>
</tr>
<tr>
<td>📚</td>
<td>Tip: Gives tips for easy handling of the Flexometer.</td>
</tr>
</tbody>
</table>

1.1.1.2. Demands on personnel

⚠️ Attention! Only qualified personnel are allowed to perform transport, mounting, installation, start-up, operation or maintenance.

Qualified personnel are people being well acquainted with transport, mounting, installation, start-up, operation or maintenance. These people must be adequately qualified for their occupations. In detail:

- Transport: Personnel skilled in treating componentries being susceptible to electrical discharge, only!
- Installation: Personnel with electro-technical apprenticeship, only!
- Start-up: Personnel with wide-ranged skills in the fields of electrotechnics and/or drive engineering, only!
- The qualified personnel must know and adhere to the following standards and directions:
  - IEC 364 respectively CENELEC HD 384 or DIN VDE 0100
  - National accident prevention directives or VBG 4
1. Introduction

Attention! The EDC appliances do contain componentries being susceptible to electrical discharge. These componentries may be damaged by incorrect treatment. Avoid the contact with highly insulating material (synthetic fibres, synthetic foils etc.)

Attention! Do not open the EDC appliances! Keep all coverings closed during operation. There is danger of dead or severe damage to persons or property.

Attention! Draw the mains plug before opening the covering of the EDCs. There is danger of dead or severe damage to persons or property.

Attention! Never disconnect any electrical connection especially at the EDC, while the instrument is still energized. In bad cases, electric arcs may emerge and damage persons or property.

Attention! After having drawn the mains plug, wait at least two minutes before touching potentially live componentries (e.g. contacts, thread bolts) or disconnecting any electrical connection. After disconnection of the supply voltage, capacitors may bear dangerous voltages for up to two minutes. For your safety, it is recommended to measure the voltage in the link and wait, until it has fallen below 40V.

1.1.2. CE-Conformity, Directions and Standards


Low Voltage Directive (73/23/EEC): The harmonized standards of the series prEN 50178 in connection with EN 60204 are used for our appliances.

EMC-Directive (89/336/EEC) and (2004/108/EC): Under observance of the installation instructions of this documentation, we herewith declare the meeting of the objectives of the EMC Law (EMCG) for facilities and instruments with the following standards:


In this documentation, you will find instructions for the EMC-compatible installation, such as shielding, grounding, manipulation of plugs and laying of wires.


The EC directive (2002/95/EC) is used for our appliances, also.

Regarding the safety of machines, the following standards are met:

DIN EN 292, DIN EN 294 part 1...4, DIN prEN 954 part 1, DIN EN 418 of 01.93, DIN EN 349 of 08.90, DIN VDE 0160 of 05.88, DIN EN 50081 part 2, DIN prEN 50082 part 2, DIN 51233 of 11.91, VW 11.062 of 10.87

Observe national rules for prevention of accidents or VBG-4.
1.1. Safety Hints

1.1.3. Specified normal Operation

The Flexometer has been designed to carry out tests of rubber samples following the standard ISO 4666/3.

Operate the Flexometer with the allowed power supply systems and under the allowed environmental conditions, only! Adhere to the instructions given in this manual.

A start-up of the instrument (i.e. the specified normal operation) is allowed for compliance with the EMC directive (89/336/EEC), only. The appliances meet the requirements of the EC Low Voltage Directive (73/23/EEC).

⚠️ **Attention!** Inappropriate handling of the Flexometer may affect the functionality of the instrument or cause severe damage to persons or property.
1.2. Description of the DOLI Ultimate Compression Flexometer

1.2.1. The System

A Flexometer is used to measure the permanent deformation and the increase in temperature of cylindrical rubber samples (following the standards ISO 4666/3, ASTM D 623 and BS 903, part A50).

For this purpose, the sample is loaded between two holders applying it with a constant load. Then, the sample is cyclically upset along its axis.

The Ultimate Flexometer is a position- and load-controlled system, all parameters and controlling jobs of which can be defined via software! The parameters can be changed for each single sample. The Flexometer works fully automated and has a silo capacity of up to 56 samples.
1.2. Description of the DOLI Ultimate Compression Flexometer

1.2.2. The Actuator

The Ultimate Flexometer is driven by a 3-phase-linear-motor, showing very high dynamic characteristics: The load is selected in a way, that the maximum Flexometer standard with 30Hz and 6.4mm stroke will be reached (3.2mm amplitude). However, smaller and larger frequencies of up to 50Hz (1.0mm amplitude) are possible, also (see chapter Vibration Absorbing System). Furthermore, compared with an eccentric or hydraulic drive, the linear motor offers the following advantages:

- low power consumption
- no water cooling
- high degree of dynamics
- electronic control
- environmental friendly
- low noise
1.2.2.1. Vibration Absorbing System

The Flexometer has been constructed for a frequency of 30Hz. When working with lower frequencies, it may start to vibrate. An absorbing system has been developed especially for this reason, increasing the spring resistance of the instrument and therefore preventing it from vibrating.

1.2.3. The Sample

The Ultimate Flexometer handles samples with a height of 25mm ±0.25mm and a diameter of 17.8mm ±0.15mm (standard Flexometer sample following DIN ASTM 623; BS 903, part A50; ISO 4666/3; JIS K 6265) as well as samples with a diameter of 30.0mm (standard sample following JIS K 6265).

1.2.3.1. Hardness of the sample

The hardness of the sample must not exceed 82 Shore A.

⚠️ Note: Having hardness degrees higher than 82 Shore A, the sample may start to jump or move from the sample holder. In both cases, a test according to regulations with 30Hz is not possible anymore.

1.2.3.2. The lower Holder

The lower holder can be replaced by a sample changer serving both sizes, 17.8mm and 30.0mm diameter.

1.2.3.3. The Input Station

With the Ultimate Flexometer, the silo known from the Standard Flexometer has been replaced by a rotary disk, being able to serve both sample sizes. With this system, up to 12 samples can be loaded into the magazine of the instrument at one time (see chapter The Magazine, too). As a result, the problem of samples sticking together as it used to occur occasionally with the old silo shape has been eliminated.
1.2. Description of the DOLI Ultimate Compression Flexometer

1.2.4. The Temperature Chamber

The test procedure can be executed inside a temperature chamber with selectable temperature.

The temperature chamber will be supplied with current, as soon as the main switch of the instrument is turned to the ON-position. The temperature chamber of the fully automated Flexometer has a software-controlled rear door, enabling the handlingarm to bring the sample into the chamber automatically. The stop positions door open and door closed are reported to the software by limit switches.

![Fig. 5: Front view of the Flexometer (trimmed area, cover removed). 1=main switch, 2=emergency-stop, 3=compressed-air display, 4=temperature chamber, 5=chamber display, 6=fan-switch](image)

1.2.5. The Preheat Station

The sample can be preheated within the temperature chamber for a selected period of time. In an automatic test course, preheating and testing of samples can overlap in time.

1.2.6. The Magazine

The magazine is organized like a high shelf storage and offers room for up to 56 samples (optionally): 1 shelf with 11 sample storages and the height measurement station, 3 shelves with 15 sample storages each. The PC handles the whole magazine administration and the handlingarm serves it completely.

![Fig. 6: Display and fan-switch of the temperature chamber (draft). 1=current value, 2=set value, 3=AUTO-switch, 4=fan-switch](image)

![Fig. 7: Inner view of the magazine (from the top site). 1=handlingarm, 2=shelf (11 storages, one height measurement station), 3=optional shelves (15 storages each), 4=input station, 5=Temperature chamber.](image)
1.2.7. The Handlingarm System

A handlingarm carries out the whole sample handling, starting with fetching the sample from the input station up to the output of the sample at the output station (optionally).

Fig. 8: Handlingarm. a) Handlingarm inside the magazine, view from the right side. b) Handlingarm inside the magazine, view from the left side. c) Function of the handlingarm (trimmed area): I. Lifter opens the sample storage by lifting the upper holder, II. Grips insert the sample into the station. 1=grips, 2=lifter, 3=handlingarm, 4=sample, 5=upper holder of the sample storage.
1.2.8. The Height Measurement Station

The Flexometer automatically measures the height of the sample before \( (h_0) \) and after the test \( (h_e) \) (having a standard Flexometer test). In the meantime, the sample stays inside the sample storage with environmental temperature. This guarantees exact and comparable results for all samples. In case of height \( h_0 \) exceeding the tolerances \( (25.0\text{mm} \pm 0.25\text{mm}) \), the sample will directly be brought to the output station (garbage).

![Fig. 9: Inner view of the magazine. 1=incremental gauge of 2, 2=height measurement station, 3=sample storages, 4=input station, 5=Handlingarm.](image)

1.2.9. The Puncture Needle

After the end of the test, a pneumatically controlled puncture needle punctures inside the sample and measures the centre temperature of it. Optionally, a linear controlled needle can be used to stay inside the sample (at the middle height of it) during the whole test course.

1.2.10. The Output Station (Garbage)

After the test course has finished, the samples can be given out in batches or as single samples.
1.3. Specifications

**Compressed-air supply:** 6 bar, 1l/min  
Inner diameter of the hose of the instrument: 6mm

⚠️ **Attention!** The compressed-air must be absolutely clean and free of water and oil! Otherwise, a severe damage of the Flexometer may be caused.

**Power supply:**  
TN-S  \(\Delta 400\text{V}_{\text{ac}}, 50\text{Hz}, 1.5\text{kW}\)  
(for Canada, USA:  
TN-S  \(\Delta 200...210\text{V}_{\text{ac}}, 60\text{Hz}, 1.5\text{kW} ; U_N 120\text{V}_{\text{ac}}, 60\text{Hz}\) )

---

**Fig. 10: Voltage supply connection plan (draft). a) World, b) Canada/USA**
1.3. Specifications

Dimensions:

Fig. 11: Dimensions of the Ultimate Flexometer (draft). a) View from the top site: Recommended space, b) View from the front site: Height.

Delivery Data

Packing: Wooden box on euro pallet
Size (incl. Box and pallet) W 120cm, D 80cm, H 193cm
Weight: net 435kg, incl. packing 485kg

Environmental Conditions:

Temperature: +5°C to +40°C
Humidity: max. 50% at +40°C
          max. 90% at +20°C
Frost: The instrument must not be exposed to frost!
If possible, operate the instrument in an air conditioned lab.

Sample

Material: Rubber
Size: Height 25.0mm ±0.25mm, diameter 17.8mm ±0.15mm or 30.0mm ±0.15mm
Hardness: max. 82 Shore A

1.4. Online - Help

The Online help system needs the Microsoft Internet Explorer Version 5.0 or higher and the operating system Microsoft Windows XP or higher.
2. OPERATION

2.1. Security

In order to protect man and machine, the Ultimate Flexometer has security sensors, causing a shut-off of the instrument or single subunits in case of doors or coverings being opened during the test course.

⚠️ Note: The security shut-off causes a loss of the actual test data!

2.1.1. Sensors of the Temperature Chamber

2.1.1.1. Front Door

![Front Door Image](image)

*Fig. 12: Front door of the temperature chamber, open. 1=security sensors.*

2.1.1.2. Rear Door

![Rear Door Image](image)

*Fig. 13: Temperature chamber, rear view. 1=temperature chamber, 2=rear door, 3=security sensors for the rear door, 4=message sensor for the rear door.*
2.1. Security

2.1.1.3. Position of the Temperature Chamber

Fig. 14: Test area, temperature chamber tipped. 1=security sensors, 2=preheat station, 3=test area.

2.1.2. Sensors of the Magazine

Fig. 15: Flexometer (front view, trimmed area). 1=lid, 2=fan, 3=security sensors for the lid, 4=temperature chamber.

Furthermore, the instrument has security sensors for the coverings on the right rear and left side.
2. Operation

2.1.3. Overview

Table 2: Overview of the reactions of the Flexometer to the activation of the safety sensors.

<table>
<thead>
<tr>
<th>Action</th>
<th>Feedback of the Instrument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature chamber: front door opens</td>
<td>Linear motor shuts off</td>
</tr>
<tr>
<td></td>
<td>Upper holder stops</td>
</tr>
<tr>
<td>Temperature chamber: rear door opens</td>
<td>Linear motor shuts off</td>
</tr>
<tr>
<td></td>
<td>Upper holder stops</td>
</tr>
<tr>
<td></td>
<td>Handlingarm stops</td>
</tr>
<tr>
<td>Temperature chamber tips</td>
<td>Linear motor shuts off</td>
</tr>
<tr>
<td></td>
<td>Upper holder stops</td>
</tr>
<tr>
<td></td>
<td>Handlingarm stops</td>
</tr>
<tr>
<td>Magazine lid opens</td>
<td>Handlingarm stops</td>
</tr>
<tr>
<td>Magazine lid opens and rear door opens</td>
<td>Linear motor shuts off</td>
</tr>
<tr>
<td></td>
<td>Upper holder stops</td>
</tr>
<tr>
<td></td>
<td>Handlingarm stops</td>
</tr>
<tr>
<td>Temperature chamber: front door and rear door opens</td>
<td>Linear motor shuts off</td>
</tr>
<tr>
<td></td>
<td>Upper holder stops</td>
</tr>
<tr>
<td></td>
<td>Handlingarm stops</td>
</tr>
</tbody>
</table>
2.2. Flexometer

2.2.1. Switch-On

1. The main switch (see Fig. 16, no 1) has to be turned to the ON-position. The initialisation of the hardware starts. It takes approx. 1 minute. Now, the temperature chamber is supplied with current.

2. Use the fan-switch (no 6) at the temperature chamber (no 4) to turn on the heater and the fan. Now, the temperature chamber can be controlled completely via software. The automatic mode (display AUTO in the display field, no 5) has been preset. If not (mode Manual, display MAN), the mode has to be changed to Automatic with the Auto-switch (below the display). The display REM will blink (remote control) to show, that communication between temperature chamber and PC is active.

3. Turn the compressed-air valve in the back of the Flexometer (see Fig. 17, no 1) into flow-through position (longitudinal to the hose).

4. Now, start the Flexometer software DOLIFlex. The Flexometer carries out the needed reference drives by itself.

Fig. 16: Front view of the Flexometer (trimmed area, covering removed). 1=main switch, 2=emergency-stop, 3=Compressed-air display, 4=temperature chamber, 5=chamber display, 6=fan-switch

Fig. 17: Compressed-air unit and outlet box in the back of the instrument. 1=compressed-air valve, 2=compressed-air setting valve, 3=compressed-air display, 4=water separator, 5=water separator valve, 6=maintenance access for the filter mat.
2. Operation

2.3. Program

2.3.1. Start and Control

2.3.1.1. Start of the Program

Main Menu Window

After the start of the DOLIFlex-Software, the main menu window opens:

![Main Menu Window Diagram]

The main menu window contains several sections, the datagrid, the graphics section, the "digital display" section and the "function field" section. Please see the paragraphs below for further explanation.

Datagrid

On the left side, there is the datagrid for the administration of defined sample data. Depending on the capacity of the Flexometer, this grid can contain up to 56 records. The states of the single samples are shown by the colour markings (see chapter Legend, also). Sorting of the records happens following the entry order, the youngest of which standing on bottom of the list, the oldest one on top. Processing of the samples happens from the top to the bottom of the list.

Fig. 18: Main menu window. 1= datagrid for sample data; 2= graphic section with the scalings for the following graphs: 2a= Deformation, 2b= Contact temperature, 2c= E', 2d= tan d, 2e= E*, 2f= E''(2c to 2f = viscoelastic properties); 3= Numerical display section; 4= Function fields for 4a= sorting of the sample data in the datagrid, 4b= loading of the samples, 4c= administration of the sample data, 4d= control of the test procedure; 5= Main menu line.
2.3. Program

bottom, meaning that the oldest sample will be processed first. The function fields above the datagrid (4a) are used to change the order of processing (see chapter Control with the Function Fields, also).

Tip: A single file can be marked by clicking on it, more than one can be marked by “CTRL + mouse click”.

Graphic Section

The right side of the dialog window shows the graphic section for the display of the graphs for “Deformation” and “Contact temperature” (at the lower holder) in relation to the test time. Furthermore, the graphs for the viscoelastic properties of the sample are shown: $E^*$, $\tan \delta$, $E'$, $E''$. The colours of the graphs do correspond to the related scalings in order to increase the clearness of the diagram.

During the test course, the graphs will be displayed in real-time.

Digital Display Section

<table>
<thead>
<tr>
<th>Time [hh:mm:ss]</th>
<th>Contact temp. [°C]</th>
<th>Deformation [%]</th>
<th>Prestress/Preload [N]</th>
</tr>
</thead>
<tbody>
<tr>
<td>000:00:00</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>$\tan \delta$</td>
<td>$E^*$ [MPa]</td>
<td>$E'$ [MPa]</td>
<td>$E''$ [MPa]</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

*Fig. 19: Digital Display Section.*

The digital display section shows the digital values for:

- **Time [hh:mm:ss]** This display shows the actual test time.
- **Contact temp. [°C]** This display shows the contact temperature at the lower holder.
- **Deformation [%]** This display shows the actual deformation of the sample in % of the height $h_0$.
- **Prestress/Preload [N]** This display shows the prestress / preload, the sample is impinged with.
- **$\tan \delta$** Dissipation factor (tangent of loss angle)
- **$E^*$ [MPa]** Complex elastic modulus
- **$E'$ [MPa]** Reversible resilience (stored energy)
- **$E''$ [MPa]** Irreversible loss of energy
Function Fields

Fig. 20: Function fields 4a= for the datagrid, 4b= to load/unload samples, 4c= the administration of the sample data, 4d= the control of the test procedure.

The function fields are used to change the order of the sample records in the datagrid (4a), to load or unload samples (4b), to administrate sample data (4c) and to control the test course of the DOLI Flexometer (4d). For further explanation, please see chapter Control with the Function Fields.

Main Menu Line

Fig. 21: Main menu line.

The main menu line contains the menus File, Flexometer, Sample and ? (Help). For further explanation, see chapter Control with the Main Menu Line.)
2.3. Program

2.3.1.2. Control with the Function Fields

There are different ways to control the DOLIFlex-Software: with the function fields, with the popup-menu or with the main menu line. This section describes the function fields.

Function fields for the datagrid

A data file has to be marked before editing:

- **Move up sample in the grid**
  The chosen record will move upwards for one position.

- **Move down sample in the grid**
  The chosen record will move downwards one position

- **Move sample in the grid to the selected position**
  The chosen record will move to a defined position: A dialog window (Go to position) opens, where the new position can be entered into.

Function fields to load/unload samples

- **Rotate wheel**
  Clicking on this function field will cause the input station to turn itself for one position in order to transport the sample into the working area of the handling arm. Clicking on function field **Load** will then cause the handling arm to fetch it and bring it into the magazine.

- **Load selected samples**
  This opens the dialog window **Samples**. The shown sample will be taken from the input station and loaded into the sample storage. Clicking on **STOP** will interrupt the loading.

- **Unload selected samples**
  The marked sample will be fetched from the sample storage and moved to the output station. Clicking on **STOP** will interrupt this action.

Function fields for the administration of the sample data

- **New**
  Opens the window **Parameter for**: for creating a new sample record.

  **Tip**: If there is a record with similar data inside the datagrid already, mark this one and then click on **New**. The dialog window will contain all data of the marked record. This way, similar data must only be edited (and not entered completely new).

- **Delete**
  Deletes the marked record.

- **Open Archive**
  Opens the dialog window **Archive** containing the records of samples, that have been tested and moved to the archive.

Function fields for the control of the test procedure

- **Start**
  The next Flexometer test will be started, i.e. the not tested sample standing on top of the list.
2. Operation

Pause
The Flexometer stops after the end of the actual running test. All samples being in the actual test course will be tested and the data will be stored. Then, the Flexometer pauses. In order to start with the next test course, the function field Start has to be activated again.

Stop
The running test will be stopped immediately, i.e. the preheat station, the test area and the height measurement station will stop and their samples cannot be tested furthermore. This is valid for the samples being in the sample storages for cooling, also. They will not be height measured anymore. (The handling arm finishes its movement, inserts the sample into the station and stops.) All data detected so far will be stored. Clicking Start will cause the instrument to start with a new sample.

2.3.1.3. Control with the Popup-Menu
This menu can be opened by clicking the right mouse key in the designated dialog window or section.

Popup-Menu for the datagrid (main menu window)

New creates a new sample record
Delete deletes the selected sample record
Pause stops the Flexometer after the end of the running test
Select all selects all records in the grid

Fig. 22: Popup-menu for the datagrid of the main menu window.

Popup-Menu for the graphics section (main menu window)

Clicking the right mouse key in the graphics section of the main menu window opens the dialog window Scale options. Here, you can define the scalings for the single axes (in the fields Min and Max), display grids for the single values (checkmark box Grid) and change the background colour of the online graphic (selection field Background colour of the online graphic).
2.3. Program

2.3.1.4. Control with the Main Menu Line

The DOLIFlex software can be controlled via the main menu line in the main menu window, also.

Fig. 24: Main menu line.

File

Clicking on the menu item File, the following choice will appear:

- **Settings** opens the dialog window Ultimate Flexometer Options (password-protected)
- **Move Archive** opens the dialog window Move archive, which can be used to select a new destination for the archive.
- **Exit** Closes the DOLIFlex software.

Fig. 25: Menu File

Flexometer

Clicking on the menu item Flexometer, the following choice will appear:

- **Machine** incl. submenu
- **Chamber** incl. submenu
- **Power on** Switches on the EDC
- **Power off** Switches off the EDC
- **Debug messages** Opens the window Debug messages containing debug messages from the EDC.

The submenu Machine offers the following choice:

- **Supervisor** Opens the dialog window Supervisor

Note: This dialog window is for the supervisor and the DOLI-Service only and therefore it is protected by a password!

- **Signals** Opens the dialog window Signals

See chapter Status Information for further details.

The submenu Chamber offers the following choice:

- **Preheat** starts preheating sequence in the temperature chamber with the set temperature
- **Off** temperature chamber control will be shut off

Fig. 26: Menu Flexometer

Fig. 27: Submenu Machine

Fig. 28: Submenu Chamber
2. Operation

Sample

Clicking on the menu item **Sample**, the following choice will appear:

- **New**
  Creates a new sample record

- **Delete**
  Deletes the selected sample record

- **Archive**
  Opens the dialog window **Archive** containing records of tested samples.

- **Load sample**
  opens the dialog window **Samples**. The selected sample will be taken from the input station and loaded into the sample storage.

- **Unload sample**
  The marked sample will be fetched from the sample storage and moved to the output station.

- **Rotate wheel**
  the input station turns itself for one position in order to transport the sample into the working area of the handlingarm.

- **Move up**
  The chosen record will move upwards for one position.

- **Move down**
  The chosen record will move downwards for one position.

- **Move to position**
  The chosen record will move to a defined position: A dialog window (**Go to position**) opens, where the new position can be entered.

Fig. 29: Menu Sample

? (Help)

Clicking on the menu item **? (Help)**, the following choice will appear:

- **Contents & Index**
  calls up the online-help

- **Legend**
  opens the dialog window **Legend**; see chapter **Legend**, also.

- **Test specification**
  opens the dialog window **Test specification**, see chapter **Security**, also.

- **Testing machine information**
  opens the dialog window **Testing machine information**, see chapter **Security**, also.

- **Testing machine protocol**
  opens the dialog window **Testing machine protocol**, see chapter **Security**, also.

- **About...**
  general information about the DOLIFlex software, the instrument and DOLI.

Fig. 30: Menu ? (Help)
2.3. Program

2.3.2. Flexometer Settings

Use the path **File → Settings** (incl. security check) to open the dialog window **Ultimate Flexometer - Options**. It is divided into 7 submenus:

![Ultimate Flexometer - Options](image)

**Fig. 31: Flags of the dialog window Ultimate Flexometer - Options.**

**Note:** Each change of the options needs to be followed by a new program start!!

### 2.3.2.1. Hardware

**Options**

**Customer-ID:** Field for customized names (no effect on the test)

**Holder cooling time:** Here, insert the wished holder cooling time.

**Note:** Keeping a definite cooling time at the end of the test (normally 5 minutes) will prevent the next sample from an unintended warm up by the lower holder (which may still be warm from the previous test).

**Flexometer**

**Calculation mode:** There are two different ways to calculate the deformation in %. Mode 0 is the standard mode normally used for flexometers. This mode has been preset and should be used for your tests. (Mode 1 is for future test types, only).

**Manual Flexometer ?:** In case of a dysfunction of the handlingarm, this option can be activated: Despite the dysfunction, the Flexometer will continue in the manual mode without the handlingarm. (The configuration has been preset by the DOLI service).

**Samples**

This function block is for entering the sample height and the permissible variations.

**Sample diameter:** Furthermore, the diameter can be entered: 17.8mm (standard) or 30.0mm (optional).
2. Operation

2.3.2. File Management

2.3.2.2. File Management

Data directory
The path leading to the storage directory for sample data is entered here.

Fig. 33: Window Files.

Click on the function field to open the needed dialog window.

2.3.2.3. Filename

Unlock filename for input: This enables the user to define the filename in the Parameter window freely (see chapter Input of the Sample Parameters, also).

Filename
Up to 3 fields can be chosen to compose the name of the result file (ASCII-Format) out of.

Fig. 34: Window Filename.
2.3. Program

2.3.2.4. Language/Print/Formula

**Language**

**Display language**: represents the language of the Flexometer software. All dialog windows and printouts will appear in the chosen language.

The following languages are available:

1. German
2. English

**Print**

Set a checkmark if you want to have the possibility to print the results.

**Formula generator**

Clicking on the function field Result parameters will open a dialog window for entering different formulas for further results. These results will show up in the dialog window Tested Samples as well as in the printouts.

Up to four formulas can be entered in order to get additional results out of the tests. The results will show up on the printouts and on the screen.
2. Operation

2.3.2.5. Display

Parameters

This submenu offers the possibility to change the names of single program parameters.

Fig. 37: Window Display.

2.3.2.6. Graphic

Time scale

There are two different scaling types.

Fixed scale: No further settings are needed. The scale depends on the actual test time.

Variable scale: The user is free to choose scalings according to his needs (possible units: hours, minutes, seconds).

Scale for deformation, holder temp. etc.

User-release for scale options: The user has the possibility to re-scale the online-graphic per right mouse-click.

The following options define the look of the graphics: grids for the single axes, minimum and maximum values for the scalings.

The settings chosen in this submenu will automatically be taken as base for a new parameter file (see chapter Input of the Sample Parameters, also).

Standard: This function field returns all settings to the preset standard values.

Background colour of the online graphic

Here, it is possible to change the background colour of the online graphic.

Fig. 38: Window Graphic.
2.3. Program

2.3.2.7. Security

Fig. 39: Window Security.

Change password

Activating the function field Change password opens a dialog window, enabling the user to define or change a password (no password preset).

Machine information

This function block is for creating the dialog windows in the submenu ? (Help) (main menu window, see chapter Control with the Main Menu Line, also).

Special

Note: This function is for the DOLI service only and therefore, protected by a password.

Before defining a new password, the old one has to be entered!

Fig. 40: Window Change password.
2. Operation

2.3.3. Sample Parameters

2.3.3.1. Input of the sample parameters

There are different ways to open the dialog window Parameter for... A differentiation has to be made, whether files have to be edited or newly entered.

Note: However, the following is valid for each case: If a file is selected, it will be opened as pattern.

New

Click on icon New (alternatives: open the popup menu in the datagrid (right mouse key) and click on icon New or open the menu Sample → New in the main menu line). The window Parameter for.. opens with a white frame surrounding the input area (see picture below).

Edit an existing file

Double click on a file. The window Parameter for.. opens with a yellow frame surrounding the input area.

![Window "Parameter for.." for the parameter entry.](image)

Fig. 41: Window "Parameter for.." for the parameter entry.
2.3. Program

Testing time
Input of the testing time in hours and minutes (max. possible: 999 hours and 59 minutes)

Cooling time
Input of the cooling time of tested samples in hours and minutes (max. possible: 99 hours and 59 minutes).

Chamber
Input of the temperature for the temperature chamber.

Note: An entry of 0°C means no preheat of the sample before the test. However, with this entry, the preheat time should be set to 0 also, otherwise the handling arm will insert the sample into the preheat station.

Preheat time
Input of the preheat time in hours and minutes (max. possible: 99 hours and 59 minutes)

Maximal Deformation
Input of the max. deformation in percent.

Note: The input must be between -50% and 0%. For reasons of hardware, a deformation higher than -55% is not possible. It would definitely damage the instrument.

Filename
Input of the filename for this parameter file. In case of an activation of the automatic name composition (Flexometer Settings → Filename), the software automatically enters the name (composed out of up to three parameter fields; see chapter Filename, also).

Note: However, special characters at the beginning of the filename will definitely cause problems with the file management in Windows. If the filename is entered manually, any kind of file extension must not be entered, as the program adds them automatically.

Move control (control mode)
This field is for choosing the control mode, the instrument should run with. The mode Deformation has been preset and should not be changed.

Test procedure
This is the field to choose the wished test type. Possible test types are:
- Flextest: standard Flexometer test
- Blowout deformation
- Blowout temperature
For descriptions, see chapter General Test Description.

Blowout factor
This field is relevant only for Blowout tests (see chapter Blowouttest). The factor 3 has been preset, it can be changed if necessary.

Stroke
The stroke has been preset to 4.45mm (standard value) but can be changed.

Attention: By means of hardware reasons, it has to be within the range 1.0mm and 7.0mm.

Prestress/Preload
The load, the sample is tested with, has been preset to 1MPa but can be changed.
2. Operation

Frequency

The testing frequency has been preset to 30Hz but can be changed. For lower frequencies, the software automatically activates the “vibration absorbing system” (see chapter Description of the DOLI Ultimate Compression Flexometer).

⚠️ Attention: By means of hardware reasons, the frequency has to be within the range given behind the field.

Sample height / Sample diameter

This field shows the entries already made in Flexometer Settings → Hardware (see previous chapter, also).

⚠️ Note: In case of the existence of a height measurement station, the software enters the detected height into the first field and deactivates it.

Axis scale

The axis scalings have already been defined in Flexometer Settings → Graphic. This field offers the possibility to change the scalings due to the experiences of the user (recommendations for standard samples: deformation 10% to -50%; holder temperature 50ºC to 150ºC).

Tip: For means of graphics comparability, it is recommended to keep the chosen scaling for all tests.

Compound to Comment

These fields are pure comment fields without any influence to the test. (Having activated the automatic name composition, the file name will be composed out of the chosen parameter fields; see chapter Filename, also).

Results after

If you want to have intermediate results after a certain time, enter the time here and the software will store the results after this time.

Graphic print

If the option Print has been released in Flexometer-Setting → Language/Print/Formula, a checkmark at this place will enable you to printout the results.

Unload automatic

If this function is activated, the sample will be moved to the output station after the end of the test course. Otherwise, it will be moved to the sample storage.

Compression set (1hrs)

Choose, whether the sample should be height measured again after one hour cooling time in order to calculate the compression set after 1 hour.

Show tangent Delta

Choose, whether tan D should be displayed in the graphics or not.

Show E*

Choose, whether E* should be displayed in the graphics or not.

Show E'

Choose, whether E' should be displayed in the graphics or not.

Show E''

Choose, whether E'' should be displayed in the graphics or not.

Sample count
2.3. Program

Enter the number of samples that are to be tested with these parameters.

⚠ Note: This option is possible for the creation of a new file, only.

**Function fields**

⚠ Note: If you opened a new file, the function fields Open, Save and Help are active. If you opened an existing file, the function fields Save, Help, Back and Next are active.

- **Open**: This function field opens a dialog window where you can search and import existing flexometer files with.
- **Save**: This function field opens a dialog window used for storing files.
- **Help**: This function field opens the online-help of the flexometer software DOLIFlex.
- **Back**: With this function field, you can change to the input mask of the previous file in the datagrid.
- **Next**: With this function field, you can change to the input mask of the next file in the datagrid.
2. Operation

2.3.4. Status Information

2.3.4.1. Supervisor Menu

Via the menu Flexometer → Machine → Supervisor (and a password check), the window Supervisor opens.

Note: This mode is for the supervisor and the DOLI Service, only!! It is used for installation and checking of the hardware functionality. For this reason, it is protected by a password.

Fig. 42: Supervisor-window. 1= digital displays of the measurement values, 2= states of the digital inputs, 3= states of the digital outputs, 4= states of the limit switches, 5= states of the control, 6= states of the EDC, 7= display of the running time of the instrument, 8= function blocks for the control of hardware components.
2.3. Program

2.3.4.2. Signals Menu

Via the menu Flexometer → Machine → Signals, the window Signals opens. It is consistent to the supervisor window in inactive mode.

![Window Signals](image)

The inactive mode is accessible for each user and is for information, only. All function blocks and fields are inactive, but the digital displays and the checkmark boxes are active and do show the actual state of the Flexometer.
2. Operation

2.3.4.3. EDC - Messages

You can open the window Debug Messages via menu Flexometer → Debug Messages.

![Debug Messages](image)

These messages help to precise states and to recognize possible errors more easily.

The massages will not only be displayed by the software but also stored in a logfile on the hard disk (FlexLog1.txt and FlexLog2.txt).

Basically, the messages will be stored into the file FlexLog1.txt. If the data amount extends a certain degree, all data will be stored into the second file and the first one will automatically be used to store new data.

This dialog window can be opened with CTRL+M, also.
2.3. Program

2.3.4. Legend

Via the menu ? (Help) → Legend a legend will open explaining the colour code for the state of the single samples.

![Legend](image)

*Fig. 45: Legend for the state of the samples.*

2.3.4.5. Invalid Samples

In case of the appearance of this dialog window, errors have been caused during a test course. The Flexometer is unable to handle the shown samples. For this reason, they must be removed manually from the system.

![Invalid samples](image)

*Fig. 46: Dialog window Invalid samples.*
3. TEST

3.1. General Test Description

A Flexometer is used to measure the permanent deformation and increase in temperature of cylindrical rubber samples. For this purpose, a sample is loaded between two holders applying it with a constant load. Then the sample is cyclically upset along its axis.

During the test course, the following values will be measured:

1. Test time
2. Contact temperature at the lower holder
3. Deformation of the sample
4. Prestress/preload

The curves

1. Contact temperature at the lower holder
2. Deformation of the sample

in relation to the test time will be displayed in real time.

Optionally, it is possible to detect viscoelastic properties of the sample (see chapter Viscoelastic Properties). Then, the curves for

1. tanD
2. E*   
3. E’   
4. E”   

will be displayed in relation to the test time, too.

An incremental encoder measures the deformation in percent (%) of the initial height h₀ of the sample, i.e. 100% correspond to a change in height of 25mm. Immediately after the termination of the test (and if needed one hour after the test) a puncture needle injects into the sample, measuring the centre temperature of the same. After the test, the measurement data can be printed.

The following sections do explain different test types.
3.2. Flextest

The standard Flexometer test. Test course with all possible hardware options:

1. **Entry of the sample data** by the user.
2. **Filling up the input station** (rotary disk with 12 sample places) by the user.
3. **Loading the sample storages** (**main menu window**, function field **Load**). Handling arm fetches samples from the input station and inserts them into the sample storages.
4. **Start of the test** (**main menu window**, function field **Start**).
5. Insertion of the sample into the height measurement station (by the handling arm) and measuring of the height (with option height measurement station, only) - if necessary, rejection of sample.
6. Insertion of sample into the preheat station and preheat of the sample (with option preheat station, only).
7. Insertion of sample into the test area. Linear motor will be activated, pneumatic cylinder (for the parking position of the crosshead for the upper holder) will be deactivated.
8. Linear motor drives crosshead to a clamp load of 5N for means of clamping the sample (Handling arm releases the sample and moves to parking position).
9. **Dynamic test**, controlled by the linear motor. Permanent detection of the values "Contact temperature at the lower holder", "Deformation" and "Prestress/Preload" (displays and graphics in the **main menu window**).
10. Test end happens at the end of the given test time, at exceeding of the maximum allowed deformation or at abortion by the user. Upper holder keeps its position.
11. Detection of the center temperature of the sample by the puncture needle. (Puncture needle punctures into the center of the sample, measures the temperature and comes out again. The software stores the detected temperature maximum as center temperature.)
12. Linear motor drives the crosshead back to the clamp load of 5N.
13. Handling arm fetches the sample, linear motor drives the crosshead back to parking position, pneumatic cylinder will be activated, linear motor will be activated (pneumatic cylinder keeps the crosshead in parking position).
14. Insertion of sample into the height measurement station and measuring of height; calculation of deformation out of the height (with option height measurement station, only).
15. Insertion of sample into the sample storage for the given cooling time (with option magazine, only).
16. Once again: Insertion of sample into the height measurement station (e.g. after one hour) and measuring of height; calculation of static deformation out of the height (with option height measurement station, only).
17. Insertion of sample into the sample storage or the output station.
3. Test

3.3. Blowout Test Deformation/Temperature

During the Blowout Test, the sample will be impinged with enough energy to cause a gasification of different components of the rubber compound inside the sample. The event of the escape of gas out of the sample is called “Blowout”.

The software uses the acceleration graph for recognizing the Blowout. This curve represents the first differentiation of the deformation- and/or the temperature graph:

![Acceleration graph of the Blowout Test (draft).](image)

After a response time of 20 seconds the software measures the tolerance band (Δ) of the graph for a period of 10 seconds and normalizes its width to the value 1.

The Blowout causes a strong change of acceleration. Therefore, the graph obviously deviates from Δ. At the moment, this deviation reaches or exceeds factor 3 (this factor is an empirical value for standard samples) (Δ·factor), a Blowout will be recognized and the test stops.


3.4. Viscoelastic Properties

In addition to the standard flexometer test results, the DOLI Ultimate Flexometer is able to detect the viscoelastic properties of the sample, also.

If you want these results to be detected, you have to activate the related checkmark boxes when entering the sample parameters in the window Parameter for... (see chapter Input of the sample parameters).

The following properties are detected:

- **tan D**  
  Dissipation factor (tangent of loss angle)
- **E* [MPa]**  
  Complex elastic modulus
- **E' [MPa]**  
  Reversible resilience (stored energy)
- **E'' [MPa]**  
  Irreversible loss of energy
4. RESULTS

As soon as a sample test has been finished, the whole file will disappear from the main menu window. However, you can access the data of tested samples via the function field Open archive (main menu window) or via menu Sample → Archive. As a result, the window Archive will open.

4.1. Results Overview

The window Archive contains the data records of the tested samples as well as the related graphics.

---

Fig. 48: Dialog window Archive containing the records and graphs of the tested samples. 1= datagrid, 2= graphics section, 3= checkmark boxes for the graphics section, 4= field "Offset for X-axis", 5= function keys.

It consists of the datagrid on the left side (no 1), the graphics section on the right side (no 2). The top region consists of the checkmark boxes on top of the graphics section (no 3), the field Offset for X-axis (no 4) in the middle and the function fields on the upper left side (no 5).

The window offers the following options:

**Datagrid**

**Choose a record**

In the datagrid, you can choose a sample record by clicking on it with the left mouse key. As a result, this file will be highlighted in blue and the related graphics will be shown in the graphics section on the right.

**Open the record data**

Double clicking on a record in the datagrid with the left mouse key will open the window Results for.. (see chapter Single Results) containing all entered data and results of this record.
4.1. Results Overview

**Multichart display**

You can mark up to 5 records by pressing the CTRL key (or SHIFT key) and clicking on the wanted records. The records will be highlighted in different colours, while the related graphs will appear in the graphics section in identical colours.

**Graphics section and checkmark boxes**

**Zoom**

Move a frame around the desired field having the left mouse key pressed and then release the mouse key.

**Undo zoom**

Keep the right mouse key pressed and draw a frame from the lower right to the upper left somewhere in the graphic. Then release the mouse key.

**Scroll**

Move the cursor with pressed right mouse button

**Display or remove graphs**

Set/remove checkmarks at the boxes, if you want to display or remove graphs.

**Move the X-axis**

Entering a value on the field *Offset for X-Axis* moves the graphic in X direction.

**Function fields**

The function fields offer the following functions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Exit Closes the window.</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open Opens a dialog window for the search and upload of sample records.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete Deletes the marked sample record.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print Prints the sample record on a printer.</td>
</tr>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Preview Shows a print preview of the results.</td>
</tr>
</tbody>
</table>
4. Results

4.2. Single Results

Double clicking on a sample record in the window **Archive** opens the window **Results for...**. It contains the entered sample data (flag **Sample data**) and the results (flag **Results**) of this sample record. Click on the related flag to change the display of the wished list.

Just like the window **Parameter for...**, i.e. the sample input window, (see chapter **Input of the sample parameters**), this window is surrounded by a coloured frame. The colour shows the status of the sample. The colours are explained in the window **Legend** (menu ?(Help) → **Legend**, see chapter **Legend**, also).

Furthermore, the field **Test end reason** shows the reason for the test end and the related colour, too.

**Function fields**

The function fields **Exit**, **Print** and **Preview** have the same functions as with the **Archive** window.

With the **arrow function fields**, you can change to the **Results for...** window of the other sample records (first, previous, next, last record). As a result, the **Archive** window shows the graphs of the selected record.
4.3. Printouts

The printout contains the sample data, the graphics and the results as values.

Fig. 51: Result Printout.
## 4. Results

### 4.4. Explanation of the Results

Table 3: Explanation of the test results

<table>
<thead>
<tr>
<th>Result</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test end reason</td>
<td>Reason for test end (abortion, regular test end, etc.)</td>
</tr>
<tr>
<td><strong>Gauge</strong></td>
<td></td>
</tr>
<tr>
<td>Gauge start</td>
<td>sample height before test, <em>l₀</em> in [mm]</td>
</tr>
<tr>
<td>Gauge end hot</td>
<td>sample height at test end in [mm]</td>
</tr>
<tr>
<td>Gauge end cold</td>
<td>sample height after cooling time in [mm]</td>
</tr>
<tr>
<td>Gauge after 1 hrs.</td>
<td>sample height after 1 hour of cooling time in [mm]</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Inner temperature</td>
<td>Center temperature of the sample at test end in [°C]</td>
</tr>
<tr>
<td>Room temp. start</td>
<td>Room temperature at test start in [°C]</td>
</tr>
<tr>
<td>Room temp. end</td>
<td>Room temperature at test end in [°C]</td>
</tr>
<tr>
<td>Contact temp. start</td>
<td>Temperature of the lower holder at test start in [°C]</td>
</tr>
<tr>
<td>Contact temp. end</td>
<td>Temperature of the lower holder at test end in [°C]</td>
</tr>
<tr>
<td><em>dT</em></td>
<td>Temperature difference at the holder after test end:</td>
</tr>
<tr>
<td></td>
<td><em>dT</em> = <em>T</em>&lt;sub&gt;test end&lt;/sub&gt; - <em>T</em>&lt;sub&gt;start&lt;/sub&gt; in °C</td>
</tr>
<tr>
<td><em>dT</em>&lt;sub&gt;25&lt;/sub&gt;</td>
<td>Temperature difference at the holder after 25 minutes:</td>
</tr>
<tr>
<td></td>
<td><em>dT</em>&lt;sub&gt;25&lt;/sub&gt; = <em>T</em>&lt;sub&gt;25 minutes&lt;/sub&gt; - <em>T</em>&lt;sub&gt;start&lt;/sub&gt; in °C</td>
</tr>
<tr>
<td><strong>Fatigue life</strong></td>
<td>Number of strokes at test end</td>
</tr>
<tr>
<td><strong>Creep</strong></td>
<td></td>
</tr>
<tr>
<td><em>Ft</em> = 100% x ( <em>h₀</em> - <em>hₜ</em> ) / <em>h₀</em></td>
<td>Deformation after 6 seconds:</td>
</tr>
<tr>
<td><em>h₀</em> = deformation after start</td>
<td></td>
</tr>
<tr>
<td><em>hₜ</em> = deformation after test end</td>
<td></td>
</tr>
<tr>
<td><strong>Testing time</strong></td>
<td>Testing time</td>
</tr>
<tr>
<td><strong>Formula</strong></td>
<td></td>
</tr>
<tr>
<td>Formulas and results as defined in Flexometer Settings → Language/Print/Formula.</td>
<td></td>
</tr>
</tbody>
</table>

### Deformation

<table>
<thead>
<tr>
<th>Result</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression set hot</td>
<td>Deformation of the sample after test end in %</td>
</tr>
<tr>
<td>Compression set cold</td>
<td>Deformation of the sample after cooling time in %</td>
</tr>
<tr>
<td>Compression set 1 hrs.</td>
<td>Input parameter: &quot;Compression set 1 hrs.&quot;. Deformation of the sample after 1 hour of cooling time in %</td>
</tr>
<tr>
<td>Static compression</td>
<td>Static deformation of the sample in % (measured in the testing area)</td>
</tr>
<tr>
<td>Flexing compression start</td>
<td>Dynamic deformation after 5 seconds of testing time in %</td>
</tr>
<tr>
<td>Flexing compression end</td>
<td>Dynamic deformation after test end in %</td>
</tr>
</tbody>
</table>

### Tan D

<table>
<thead>
<tr>
<th>Result</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tan D start</td>
<td>Dissipation factor (tangent of loss angle) at start of the test</td>
</tr>
<tr>
<td>Tan D end</td>
<td>Dissipation factor (tangent of loss angle) at end of the test</td>
</tr>
<tr>
<td><em>E</em>&lt;sup&gt;′&lt;/sup&gt; start</td>
<td>Complex elastic modulus at start of the test</td>
</tr>
<tr>
<td><em>E</em>&lt;sup&gt;′&lt;/sup&gt; end</td>
<td>Complex elastic modulus at end of the test</td>
</tr>
<tr>
<td><em>E</em> start</td>
<td>Reversible resilience (stored energy) at start of the test</td>
</tr>
<tr>
<td><em>E</em> end</td>
<td>Reversible resilience (stored energy) at end of the test</td>
</tr>
</tbody>
</table>
### 4.4. Explanation of the results

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E'' start</td>
<td>Irreversible loss of energy at start of the test</td>
</tr>
<tr>
<td>E'' end</td>
<td>Irreversible loss of energy at end of the test</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Results after</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deformation</td>
<td>Deformation of the sample after the given time.</td>
</tr>
<tr>
<td>Contact temp.</td>
<td>Temperature of the lower holder after the given time.</td>
</tr>
<tr>
<td>Tan D</td>
<td>Value for tangent Delta after the given time.</td>
</tr>
<tr>
<td>E*</td>
<td>Value for E* after the given time.</td>
</tr>
<tr>
<td>E'</td>
<td>Value for E' after the given time.</td>
</tr>
<tr>
<td>E''</td>
<td>Value for E'' after the given time.</td>
</tr>
</tbody>
</table>
5. MAINTENANCE

5.1. Maintaining the Instrument

5.1.1. Draining of the Compressed-air System

The compressed-air system of the Flexometer has equipment to separate the water from the compressed air. This equipment must be emptied:

1. The water separator has to be emptied once a week by pressing the water separator valve (no 5 in picture above).
2. Below the compressed-air unit, a filter mat can be found (behind the maintenance access, no 6). This mat must be changed every three months.
5.1. Maintaining the instrument

5.1.2. Changing the lower holder

1. Tip the temperature chamber.
2. Remove the covering of the maintenance area.
3. Use pliers to press the end of the manacle ring (see Fig. 53, no 3) and draw off the holder together with the manacle ring.
4. In the maintenance area, the holder has cable connections (no 7) to the instrument. Loosen the binders.
5. Fix the binders of the new holder:

   **Attention: red to red, blue to blue.**

6. Insert the new holder and fix it with the manacle ring.

---

**Fig. 53:** Test area (A) and maintenance area below it (B) (temperature chamber tipped, covering removed). 1=crosshead for the upper holder, 2=upper holder, 3=lower holder with manacle ring, 4=crosshead for the lower holder, 5=cylinder with puncture needle, 6=load cell, 7=wire of the lower holder.
4. Results

5.1.3. Changing the puncture needle

1. Tip the temperature chamber.
2. Remove the covering of the maintenance area.
3. Loosen the binders for the puncture needle (see Fig. 54, no 4).
4. Hold the fixing nut on top of the crosshead (no 5) while loosening the nut below it (no 3).

⚠️ Attention: You must not damage the loadcell!

5. Draw off the lower holder (see Fig. 55, no 5) incl. its mounting to the top.
6. Carefully draw off the cylinder (see Fig. 54, no 1) to the front.

---

**Fig. 54:** Maintenance area. 1=cylinder with puncture needle, 2=puncture needle, 3=fixing nuts for the cylinder, 4=cable connections of the puncture needle, 5=crosshead for the lower holder.

**Fig. 55:** Test area with preheat station (temperature chamber tipped). 1=preheat station, 2=sample, 3=crosshead, 4=upper holder, 5=lower holder with manacle ring.
5.1. Maintaining the instrument

7. Unscrew the screw (see Fig. 56, no 3) at the cylinder (no 2) and pull out the needle (no 1).
8. Push the new needle into the cylinder, close the screw and re-insert it into the instrument (from the bottom).
9. Re-insert the lower holder.
10. Fix the nuts and re-connect the cable binders:

\[\text{Attention: red to red, blue to blue!}\]

5.1.4. Cleaning the Stations

In order to prevent the samples from sticking to the stations, the latter ones must be cleaned every 6 months. This concerns the following parts: upper and lower holder of the sample storages, upper holder of the test area, the preheat station, the silos, the output station.

The parts have to be cleaned with silicon oil. In case of the use of another mild cleaner, the parts must be covered with silicon oil or talcum powder.
5.2. Spare Parts

Table 4: Spare parts for the instrument.

<table>
<thead>
<tr>
<th>Description</th>
<th>Package size</th>
<th>Order No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>lower holder, 17.8mm</td>
<td>1</td>
<td>FLX 1466</td>
</tr>
<tr>
<td>lower holder, 30.0mm</td>
<td>1</td>
<td>FLX 1467</td>
</tr>
<tr>
<td>lower holder, vario (for 17.8mm and 30mm)</td>
<td>1</td>
<td>FLX 1468</td>
</tr>
<tr>
<td>puncture needle</td>
<td>1</td>
<td>FLX 1469</td>
</tr>
<tr>
<td>filter mat</td>
<td>5</td>
<td>FLX 1470</td>
</tr>
<tr>
<td>compression tool</td>
<td>1</td>
<td>FLX 1462</td>
</tr>
<tr>
<td>manacle ring</td>
<td>1</td>
<td>FLX 4322</td>
</tr>
</tbody>
</table>
6. APPENDIX

6.1. Where is the Sample?

The software uses a code of three numbers to inform the user about the position of a sample within the Flexometer.

Table 5: Numbering of the positions.

<table>
<thead>
<tr>
<th>Position</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parking</td>
<td>0</td>
</tr>
<tr>
<td>Gauge (height measurement station HMS)</td>
<td>1</td>
</tr>
<tr>
<td>Preheat station</td>
<td>2</td>
</tr>
<tr>
<td>Holder (test area)</td>
<td>3</td>
</tr>
<tr>
<td>Garbage (output station)</td>
<td>4</td>
</tr>
<tr>
<td>Handlingarm</td>
<td>40</td>
</tr>
<tr>
<td>Input station</td>
<td>50</td>
</tr>
</tbody>
</table>

Fig. 57: Numbering of the stations in magazine 1 (draft): 1=Gauge (height measurement station), 50=input station, 110 to 134=reference positions for the single magazines.

Coding of the sample storages for the sample storage 134 (example):

<table>
<thead>
<tr>
<th>134</th>
<th>T34</th>
<th>134</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>position in the level</td>
<td>level in the magazine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>magazine number</td>
</tr>
</tbody>
</table>

Page 56
Fig. 58: Numbering of the stations in the Flexometer magazine (draft): 1=gauge (height measurement station), 2=preheat station, 3=holder (test area), 4=garbage (output station), 50=input station, 134, 234, 334, 434(reference positions for the single magazines).